

[image: Cover Image]





AB3733_Aubin_SharedCoord
Paul F. Aubin






PFACS







The Autodesk Revit Theory of Relativity: Understanding Shared Coordinates

Paul F. Aubin - Paul F. Aubin Consulting Services

AB3733

If you are
new to Revit, and particularly if you are coming to Revit with an AutoCAD®
background, the approach Revit takes to coordinates, positioning and origin
points can be a little baffling. On the surface, it appears that Revit simply
does not have a “zero” point, or any way to input precise coordinates. As with
many things, appearances are not always what they seem. Revit does indeed have
an origin and the ability to input with precision. The trick is that in Revit,
coordinates, movements and measurements are always relative to something else.
In this class, we will explore the “Revit theory of relativity” (AKA “Shared
Coordinates). You will learn how to set up Shared Coordinates, link files with
Shared Coordinates, and maintain the relationship as the project progresses. If
you have let your AutoCAD experience ruin you or have just not been able to get
your head around Revit coordinates, this session is here to help! You should
have familiarity with Revit essentials.

Learning Objectives

At the end
of this class, you will be able to:

·
Learn how to set up Survey Points and Project
Base Points

·
Understand how to set up and maintain Shared
Coordinates

·
Understand Shared Sites and how to manage
Locations

·
Understand project location, true north and
more.



About the Speaker

Paul F. Aubin is the author of many CAD and BIM book
titles including the widely acclaimed: The Aubin Academy Mastering Series:
Revit Architecture, AutoCAD Architecture, AutoCAD MEP and Revit MEP titles.
Paul has also authored video training both on his Web site and for lynda.com www.lynda.com/paulaubin. Paul is an
independent architectural consultant who travels internationally providing
Revit® Architecture and AutoCAD® Architecture implementation, training, and
support services. Paul’s involvement in the architectural profession spans over
20 years, with experience that includes design, production, CAD management,
mentoring, coaching, and training. He currently serves as Moderator for
Cadalyst magazine’s online CAD Questions forum, is an active member of the
Autodesk user community, and has been a top-rated speaker at Autodesk
University (Autodesk’s annual user convention) for many years. This year Paul
is speaking at the Revit Technology Conference in both the US and Australia.
His diverse experience in architectural firms, as a CAD manager, and as an
educator gives his writing and his classroom instruction a fresh and credible
focus. Paul is an associate member of the American Institute of Architects. He
lives in Chicago with his wife and three children. You can reach Paul at: www.paulaubin.com (click the contact
link).






Introduction

Before learning Revit, I was a long-time AutoCAD user. As a
long-time AutoCAD user, I found Revit’s “apparent lack” of coordinates quite
troubling. How were we ever supposed to place anything precisely when I can’t
type in 0,0 anywhere? Perhaps you shared my experience and frustration? After
much self-inflicted pain and anguish, I have since come to see things the Revit
way and gotten over my “AutoCAD-centric” way of thinking... I am feeling much
better now... The reality is that while “absolute” coordinates may seem
comforting in their finality and well, “absoluteness” we do not experience the
World this way. In “real life” we always have a relative view of the World
around us. When you are sitting in your office on the tenth floor of the
building, do you have the perception that you are floating high in the air, or
rather that you are really just sitting in a chair a few feet from the floor?
Our experiences in the World around us are relative. Shouldn’t our design
software be too? Well in Revit, as you have no doubt discovered, all
coordinates, movements, dimensions and measurements are always relative
to something else. In the topics that follow, we will explore the “Revit theory
of relativity” (OK, it’s not really called that). If you have let your AutoCAD
experience ruin you and have just not been able to get your head around Shared
Coordinates, this session is here to help!   
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Revit Origin and Base Points

Let’s start right in with the question of origin. I am often
asked about the origin (or 0,0) by new users of Revit. So to answer the
question, “does Revit have an origin?” the
answer is YES. So the next logical question is, “where is it?” The
simple answer, is that “it’s in the center of
the screen.” Here is a simple exercise to locate it for yourself:

1.
Launch Revit and create a new project from the
default template. 

Note: For this session, for my examples and screen shots,
I have used the Autodesk provided: DefaultMetric.rte template file included
with the US installation. 

2.
Type VG (or on the View tab, click
Visibility/Graphics), scroll down to and expand Site and the check (to turn on)
Project Base Point and then click OK. 

[image: ]

Turn
on the Project Base point using Visibility/Graphics (VG)

3.
The Project Base Point appears as a round
symbol. Select the icon and the coordinates of this point will report as 0,0,0
onscreen. 

You will also notice that it is basically in the center of
the screen (relative to the elevations). There are two alternative ways that
you can report coordinate locations onscreen. 

On the Annotate tab, you can click the Spot Coordinate
tool and add a spot coordinate symbol to the Project Base Point icon. There is
also the Report Shared Coordinates tool on the Manage tab, on the
Coordinates drop-down button. This command will allow you to click on an object
onscreen and it will display the coordinates of the point you select on the
Option Bar.  
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Reporting
Shared Coordinates

So now we can see that Revit does in fact have an origin and
it is at the center of the screen. But, not so fast, there’s more to the story.
Recall that, EVERYTHING in Revit is relative. So in order for this Project Base
Point that we now have displayed to be meaningful, it has to be defined
relative to something else. 

4.
Click on the Project Base Point icon. 

Notice that the numerical values are editable temporary
dimensions. 

5.
Click on and the E/W value and type in a new
value such as 10,000. 

You will actually see the Project Base Point and the
surrounding Elevation markers appear to shift onscreen. Elsewhere in Revit,
making such an edit works the same way; the selected element moves in relation
to the element associated with the temporary dimension. In this case where was
the movement measured from? It turns out that a
Revit project does not have one, but rather TWO origin points. The
second point is called the Survey Point. You can turn it on with VG as
well. It represents a “known point in the real world.” For example, if you
Civil Engineer gives you a survey with some established benchmark or known site
point, the Revit Survey Point will represent this. This will help you establish
the proper positioning of the project on its physical site. To see the Survey
Point: 

6.
Type VG (or on the View tab, click
Visibility/Graphics), scroll down to and expand Site and the check (to turn on)
Survey Point and then click OK. The Survey Point is triangular in shape.

By default, both points are in the same location. However,
if you are following along here and moved the Project Base Point above, you
should now have a space of 10,000 separating your two points.
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Turn
on the Survey point using Visibility/Graphics (VG)

You will notice also that the dimensions on the Survey Point
are not currently editable. However, the Survey Point icon CAN be moved; doing
so would actually shift the coordinate system (since the new location of the
moved icon would now be 0,0). Now that we have both points displayed, let’s
discuss them relative to one another. As noted, the intention of the Survey
Point is to “anchor” us in the real World. It represents a real and known
benchmark location on the building’s site (usually provided on the survey). The
Project Base point is simply a known point on the building itself (usually
chosen by the project team). Think of the
Survey Point as the coordinates in the World and the Project Base Point as
local building coordinates. For example, The Survey Point might be
located at the manhole in the middle of the street outside the building, while
the Project Base Point might be at the front door or column line intersection
A1. You can choose the point that is most convenient to the project team. What
is important is NOT specifically where the two points are, but rather their
relationship RELATIVE to one another. This is what we mean by Shared
Coordinates in Revit. Specifically, the Survey Point is a known point in the
Shared Coordinate System. It is called the Shared Coordinate System because it
represents the coordinate system of the World around us and is therefore
“shared” by all buildings on the site. The Survey Point defaults to the origin
(0,0,0) of the Shared Coordinate System, but you can move it to ANY convenient
point for your project. 

Likewise, the “Internal Coordinate System” of your building
is the building’s “local” coordinates which typically are oriented
perpendicular and parallel to something meaningful in the building. For
example, if the building has a 30° rotation on the site, it is much more
convenient to work on the building horizontally and vertically with respect to
your screen, the building’s major architectural elements and the plotted
sheets, rather than at 30°. This is the local
Internal Coordinate System and “Project North.”  
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Visualizing
the relationship between Internal Coordinates and Shared Coordinates

The existence of both coordinate systems lends meaning to
the other. If we did not have both, we would be forced to assign arbitrary
meaning to coordinate system and its origin and force the building to match the
survey or vice/versa. The Revit system allows us to keep both!






Project Location Tools

As noted above, the Project Base
Point and Survey Point can be moved. In other words, while they are located at
the origin by default, they do not have stay there. There are a few ways to move them. You can move the
point icons themselves directly onscreen using the Move tool or temporary
dimensions. There are also some commands on the Manage tab. Moving the
points onscreen offers results similar to these commands depending if the icon
is clipped or not. (Click the small paperclip icon to clip or unclip) Let’s
look at each option and command. 

·
Position>Relocate Project—This command moves your project relative to the Shared Coordinate
System. You can use it in plan or elevation views and it works just like the
Move command; you first click a base point, then a new point. The result will
be a change in the numerical offsets reported by the Project Base Point and is
basically identical to the result achieved above by editing the temporary
dimension on the Project Base Point. 
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·
Position>Rotate True North—This command changes the orientation of True North relative to the
orientation of the building. (Revit understands both True North; North with
respect to the actual site and Project North; “up” relative to the screen and
usually set parallel or perpendicular to major building geometry). To use this
command, you must be in a plan view and the plan view must have its Orientation
parameter set to True North. It behave just like the normal Rotate
command but the result impacts the orientation of the entire building relative
to the site. After rotating True North, you can see the results on the Project
Base Point and Survey Point icons. 
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To
Rotate True North, work from a plan whose Properties are set to True North

You can also rotate True North by
using the temporary dimension on the Project Base Point icon. This method does not
require that you first change the orientation of the plan view. 

·
Position>Mirror Project—This command mirrors (flips) the project with respect to the Shared
Coordinate System. Please note that all aspects of the project “flip”. So if
you flip left to right and you started with an elevation on the right named
East, the elevation that ends up on the right following this command will be
named West! 

·
Position>Rotate Project North—After adjusting coordinate systems, sometimes the plans and other
views don’t fit as nicely on the sheets. For example, if your building is much
taller than it is wide, you might wish to rotate Project North. This offers
several presets like rotate 90° or 180°. You can also rotate arbitrarily if
necessary. 

·
Coordinates>Specify Coordinates at a Point—This command allows you to click on an object at a point, an edge
or a surface. A dialog will display with editable fields where you can input
known values for the selection you made. You would find appropriate values to
input from your survey file or Civil Engineer. Using
this command, you can achieve the same results as most of the other commands
listed here but in a single step.  
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Edit
the location at a point with Specify Coordinates at a Point

·
Coordinates>Report Shared Coordinates—This command was mentioned above. Use it to get a read out (on the
Options Bar) of any point on a selected element onscreen. The read out will
display the Shared Coordinate values for the selection.  






Understanding Location

So far we have limited our discussion to just a single file.
What happens with coordinates when you begin linking other files (CAD or Revit)
into the current file? This is where Shared Coordinates really gains its
fullest value. Since Revit understands the notion of a global (or World)
coordinate system, it is pretty easy for us to “share” this coordinate system
with more than one project. All of the projects
will “share” the same basis for their positioning in the World—thus the name
“Shared Coordinates.” To fully understand the concept, let’s introduce
another new concept called: Location and Shared Sites. 

To fully describe where an object sits in 3D space (its
location), we need three dimensions East/West position (X coordinate),
North/South position (Y coordinate) and elevation (Z coordinate). We also need
the rotate angle East or West of True North. These four bits of information
uniquely position our building on the site and with respect to other buildings.
We can name such Site locations with a unique and descriptive name. This is
referred to in Revit as a Shared Site. To manage our Shared Sites, we
use the Site tab of the “Location Weather and Site” dialog. To get here, you
can use the Location tool on the Manage tab, and then click the Site tab or you
can access the Site tab directly from the Survey Point icon or the Shared Site
item on the Properties palette when a linked file is selected. 

A Shared Site is how we
describe where our building sits and how it is oriented on the site. A
project CAN have more than one Shared Site saved in the “Location Weather and
Site” dialog. By default, each project has only one Shared Site named:
“Internal.” This name simply describes the fact that the default for any
project is its “internal” local coordinate system. As you begin to save Shared
Sites, it is highly recommended that you name them more descriptively. 
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There
are several ways to access the “Location Weather and Site” dialog

In many situations, you will only require a single Shared
Site for each project file, however there may be situations where multiple
Shared Sites are appropriate and desirable. For example, in a condominium
development, the same building design may be sited multiple times in a
subdivision. You could use a single Revit file and copy it multiple times. Each
copy would be given its own Shared Site thereby allowing each instance to have
its own unique location in Shared Coordinates. 
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Visualizing
multiple Shared Sites in a Shared Coordinate system






Scenarios

There are potentially many ways that you can set up any
given project. There are also several tools and a few approaches available to
approach the setting up of Shared Coordinate systems. We have discussed many
tools, but for a little more hands-on look, I have chosen two simple scenarios.



 	Scenario 1 – a single pair of files.

 	Scenario 2 – a multi-file setup.



Scenario 1 – A Single pair of files

In this scenario, we assume two
project files that need to be linked together. (However this process would work
nearly the same with linking CAD files, but for simplicity here, I will only be
discussing Revit linking). The essential process is simple. Create each Revit project with an orientation and
location that is convenient and logical for THAT file. Do not choose a
location, origin or orientation based on the site file or any other building in
the campus. Remember, everything in Revit is relative. So determine the best
orientation and location for the project file you are in and then use that
orientation and location to build your model.  

When you are ready, from the Insert tab choose Link Revit
and locate the other file. For each pair of files that you link, you have to
perform the basic setup. That means that the
first time, you can choose any option you like for Positioning. I
recommend just using Auto - Center to Center. We will be repositioning
the next step. 

Tip: Again, this is the place where it is best to forget
about the AutoCAD past and just focus on the “Revit way” to do this. In other
words, though you are tempted to use Origin to Origin, it is rarely the best
option. 

Next you will move and/or
rotate the linked file into the correct relative position. Finally you will
save the Shared positioning and assign it to a Shared Site. That’s it.
Once you have established the relationship, Revit will maintain it for you. You
can open the other file and link in reverse, this time choose the Auto – By
Shared Coordinates option and the file will know exactly where to go! 

Let’s assume that you are positioning a building relative to
its site. If you want to try this out, create a simple building in one Revit
file (call in Building) and then create a simple site plan in another (call is
Site). You don’t need to get too fancy, just a few objects in each file is
suitable. 

1.
Open the Site project file. 

2.
Link in the Building project using Auto – Center
to Center. 

3.
Move and Rotate the building linked file to make
the building sit properly to the site. Be sure to both move and rotate the
building. This way we will have a different Project North and True North and
different base points when we are finished. 

4. After you finish moving and rotating, select the linked file and on
the Properties palette, next to Shared Site, click the <Not Shared>
button. 
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Select
the link and then click the Shared Site button on the Properties palette

In the “Shared Coordinates” dialog that appears, you will be
given the option to either Publish or Acquire the coordinates. There is a
description of each option in the dialog that appears. What it essentially
boils down to is that you are synchronizing the Shared Coordinate System
between the two files. In other words, before
this command, the two files know nothing of each other’s coordinates. After the
command, they will SHARE the same coordinates. So, which file’s current
coordinate system do you want to use for both files? Do you want the current
host file to share its system with the linked file? Or would you prefer the
linked file to share its system with the host? Typically
I like to let the site file’s coordinates to become the overall Shared
Coordinates. So in this case, since I am in the Site project and it is
hosting the Building project, I would want to “Publish” the coordinates to the
Building project (replacing its Shared Coordinate system and making it match
the site host file). Please note that regardless of which option you choose, NO
changes are made to either file’s local internal coordinates. What we are doing
right now is simply recording how we want the two files to coexist physically
in 3D space. You could simply click Reconcile here to complete your choice, but
as noted above, I highly recommend that you
take the additional step of renaming or copying the named Shared Site Position.


5.
In the “Share Coordinates” dialog, next to Building.rvt
: Internal, click the Change button. This open the “Location Weather and
Site” dialog to the Site tab. You can Duplicate or Rename the default Shared
Site named Internal. If you only require one Shared Site, simply rename it.
Otherwise, choose Duplicate. Choose a good descriptive name. You are describing
the building’s location on the site here. “Favoured Site,” “Alternate A” or
“North Quadrant” are good examples.  
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Change
the saved position and rename it more descriptively

6.
Click OK in the “Location Weather and Site”
dialog, and then click Reconcile in the “Share Coordinates” dialog. Finally to
make all the changes “stick” we must save both files. Click the Save icon on
the QAT and in the “Location Position Changed” dialog, click the Save option at
the top. 
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When
you save, you will also be prompted to save the linked file and its Site(s)

If you choose either of the other two options it undoes the
changes you have made. So neither is a good choice. The final step is to test what you have done. You can do this by
opening the other file and linking again. You cannot have both projects opened
at the same time, so close the current project first. 

7.
Close the Site project and open the Building
project. 

8.
Using VG, turn on the Project Base Point and
Survey Point icons. 

Notice that the building file remains oriented horizontally
and vertically relative to the screen. Notice that the Project Base Point and
the Survey Point are offset from one another. Notice also if you click on them
or query their coordinates that the values reflect the changes made in the
other file. 
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Open
the linked file to see the results

9.
Link in the Site file to this file. This time,
choose Auto – Bt Shared Coordinates. 
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After
establishing Shared Coordinates, you can link with them directly

Notice that the site file comes in exactly in the correct
location and orientation. Part of the beauty of
Shared Coordinates is that you only need to set them up once. From then
on, both files will “know about” each other. Feel free to experiment further
using any of the tools or techniques covered so far. 

Scenario 2 – A Multi-File Project

A multi-building project could be a single site with many
buildings, or a single building broken into multiple linked files (such as
Architectural, Structural, Mechanical etc.) You may also find the need to use
the same Revit model in more than one location on the site (this was mentioned
briefly above). 

A multi-file project includes the same considerations as a
single building project but has the extra added complexity of coordinating
multiple building models with respect to one another. Each pair of files is set
up the same way as above. The difference is
that, the Shared Coordinate System is now shared amongst ALL the files, not
just the pair. Therefore, you should consider carefully which file you
wish to execute the process from. In most cases, the Site file will be the
obvious choice. But this is not required. 






Managing Shared Sites

Establishing multiple Shared Site locations can be very
useful. There are two basic scenarios: the first (mentioned above) involves
using more than one copy of the same project on the site. The other scenario is
the establishment and saving of alternate site locations for a single building.
The set up for either scenario is similar. 

1.
Set up the initial links and save the shared
coordinates as before. 

2.
Select the linked file, copy it to a new
location. Adjust the positioning of the file (Move, Rotate or Align) as required.


3.
 Select the copied linked file. On the
Properties palette, note that the Shared Site is reset back to <Not
Shared>. Click this button. 

4.
In the “Select Site” dialog, choose the second
radio button and the click the Change button. In the “Location Weather and
Site” dialog, click Duplicate and give the new Shared Site a name. 

5.
Click OK twice to dismiss the dialogs and save
the file. 
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Copy
a linked file and then duplicate the Shared Site to give it a unique site
location

You may have noticed that this time we were not asked to
publish or acquire. This is because the relationship between the host and link
is already established. You can only use each saved Shared Site location one
time. So if you make three copies of the file, you will need at least three
named sites. You can have as many named sites as you like. This allows you to
try the building in different locations just by returning to the “Select Site”
dialog. If you need multiple copies of the building on the site (like the
condominium example) you are finished. If you only need one, simply delete the
extra copy (or copies). Doing this you can try
the building on various alternate site locations. 

6.
Delete the copied linked file and then select
the original linked file. On the Properties palette, click on the button next
to Shared Site (it will be named whatever you named your Shared Site above). 

7.
In the “Choose Site” dialog, click the Move
instance to radio button and choose the other site. Click OK to see the
results. 

Notice how the building moves to the other location and
orientation. Let’s do one last exercise. We will close the current file and
reopen the linked file. Then we can change which named location is active. 

8.
Close the current project and then open the
building file where you just added multiple saved Sites. If necessary, type VG
and turn on the Survey Point. 

9.
On the Manage tab, on the Project Location
panel, click the Location button. Click the Site tab. 

Notice the two Sites with the names you assigned. One will
have the label (Current) next to it. This is the currently active Site
location. 

10.Select the non-current Site and then click the
Make Current button. Click OK to see the result. 
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Open the linked file and make a different
Site current

Notice that the Survey Point has moved and reoriented. You have just instructed Revit to make the onscreen
project behave as if it were sited at the other location. Very cool! 



Please feel free to experiment further. Thank you for
attending. 






Further Study

You can find more information and tutorials in The Aubin Academy Master Series:
Revit Architecture. Chapter 6 includes coverage of linking files
and shared coordinates. 
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I also have Revit video training available on my website and
at: www.lynda.com/trial/paubin. 
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If you have any questions about this session or Revit in
general, you can use the contact form at www.paulaubin.com
to send me an email. 

[image: There-you-have-it-masked.png]

Thank you for attending. Please fill out your evaluation. 






OPS/AB3733_Aubin_SharedCoord_files/image019.jpg
©)

lynda.com





OPS/AB3733_Aubin_SharedCoord_files/image020.png





OPS/AB3733_Aubin_SharedCoord_files/image017.png





OPS/AB3733_Aubin_SharedCoord_files/image018.jpg





OPS/AB3733_Aubin_SharedCoord_files/image011.png
AR






OPS/AB3733_Aubin_SharedCoord_files/image012.png





OPS/AB3733_Cover.jpg
A f\ ‘

The Autodesk® Revit®
Theory of Relativity:
Understanding Shared
Coordinates

by: Paul F. Aubin

™ A
AU Autodesk University !





OPS/AB3733_Aubin_SharedCoord_files/image015.png





OPS/AB3733_Aubin_SharedCoord_files/image016.png





OPS/AB3733_Aubin_SharedCoord_files/image013.png
A ————
ety

> s
e gamait

pye—
i SRR —

it —






OPS/AB3733_Aubin_SharedCoord_files/image014.png
55
e






OPS/AB3733_Aubin_SharedCoord_files/image005.png
‘Survey Point

Project Base ot






OPS/AB3733_Aubin_SharedCoord_files/image004.png
A bt Soso et

4 Yo B
e
o B%





OPS/AB3733_Aubin_SharedCoord_files/image007.png
gt ot





OPS/AB3733_Aubin_SharedCoord_files/image006.png
[Ppem—






OPS/AB3733_Aubin_SharedCoord_files/image009.png
fariis e pro——
= - pae—

=

e (g1

Ceies iim )

here are severat
g 10 access the
S ot the
Location nessner
ke diog





OPS/AB3733_Aubin_SharedCoord_files/image008.png





OPS/AB3733_Aubin_SharedCoord_files/image010.png





OPS/AB3733_Aubin_SharedCoord_files/image001.png





OPS/AB3733_Aubin_SharedCoord_files/image003.png
coordin
symbol
onecreen

e

T e s

the coordinates report here

| Glik on an object onscreen. and = |






OPS/AB3733_Aubin_SharedCoord_files/image002.png
E0ly

Shared Ste
NS 00
EW 00
ev 00"

Project Base Point

Notth 000"






